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1 Introduction

1.1 Welcome to EasyScope II for PS40M10

EasyScope II is the easy to use but powerful Digital Sampling Oscilloscope application program for
the USB Instruments PS40M10.

It runs on any USB 1.1 or USB 2.0 equipped PC using Windows 98, 2000 or XP.

Drivers and an instrument interface DLL are provided for Linux systems.
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1.2 EasyScope II Features

· Attractive, easy to use visual display
· F.F.T. (Fast Fourier Transform) display
· Advanced trigger settings including edge and pulse triggering
· Delayed timebase function
· Integrated digital Volt meter
· Auto Set function
· Timebase from 50 ns/div to 50 ms/div
· Input ranges from 0.1 V/div to 10 V/div
· Integrated switch to halt data capture through hardware
· O.S.D. markers for voltage measurement
· O.S.D. markers for time / frequency measurement for complete sample
· Save oscilloscope screens to Windows BMP files
· Export 20 most recent oscilloscope traces to CSV files
· Screen printout facility
· AC/DC coupling support
· Support for x1 and x10 probes
· User-defined oscilloscope display colour themes
· Save and load colour themes to and from file
· Variable persistence mode display
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2 Installing EasyScope II

2.1 Installing the EasyScope II Software

Before connecting the instrument to the PC, insert the supplied installation disk into the CD-ROM
drive of your PC.  The following menu will appear after a few seconds.

Click on the "Install EasyScope II Oscilloscope Application" button to launch the EasyScope
installation program.  The following screen will appear:
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 Click on the "Next" button to bring up the License Agreement Screen.

If you agree with the terms and conditions of the License Agreement, check the "I agree" box and
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click on the "Next" button to continue the installation process else click on the "Exit" button.  The
"Next" button is disabled if you do not agree to the terms and conditions.  Agreeing to the terms
and clicking on the "Next" button brings up the following screen.

Select the directory you wish to install the EasyScope software into.  A default directory is shown
on the screen.  Unless you have good reason to change it we suggest you use the default
suggested by the installation program.  Click on the "Start" button to commence copying the files to
the EasyScope program directory.
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A progress screen (shown above) will appear as the files are installed.  After a few seconds you
should see the "Installation was completed successfully" message.  Click on the "OK" button to
complete the final stage of the installation process.
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The installation process is now complete. You can launch the EasyScope program from the
desktop by double-clicking on the EasyScope icon (pictured below).

You can also launch the EasyScope program from the Start -> Programs -> EasyScope II for
PS40M10 menu on the Windows Toolbar.

As shown above, you also have access to the EasyScope Help files and Program Uninstaller from
there.

Before using EasyScope, the USB drivers need to be installed.  This is done by plugging the
instrument into a spare USB port on the PC.  The instrument should be plugged into a USB hub
port of your PC or alternatively, a self-powered USB hub (one that has it's own power supply).

If this is the first time that the instrument has been plugged in, Windows will then request the USB
drivers for your product. See Installing the USB Drivers for further details.
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2.2 Installing the USB Drivers

Before using EasyScope the USB drivers need to be installed.  This is done by plugging the
instrument into a spare USB port on the PC.  The instrument should be plugged into a USB port on
your PC or alternatively, a self-powered USB hub (one that has it's own power supply).

In the case of Linux systems, please follow the installation instructions in the ReadMe.dat file
located in the Linux Drivers folder on the PS40M10 CD.

In the case of Windows based systems, please follow the instructions below.

If this is the first time that the instrument has been plugged in,  Windows will request the USB
drivers for your product and will display an Add New Hardware Wizard dialog box.  The example
below is for Windows 2000 but the procedure is very similar for other Windows versions.

Connect the instrument to a spare USB port on the PC or self-powered hub.  The following screen
will appear to begin guiding you through the driver installation.

Click "Next" to proceed with the installation.  The following screen will appear:
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Select the option box for "Search for a suitable driver for my device (recommended)" and click
"Next".
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Check the box for "CD-ROM drives" and un-check all others.

NOTE: If the CD is not available and the EasyScope software has already been installed, then
check the "Specify a location" box and use the Browse button to select the "Drivers\Windows
Drivers" sub-directory of the EasyScope Program Files directory instead.

Keep Clicking on "Next" until the installation is finished as per the screen below.

Click "Finish" to complete the installation of the first device.

If using Windows 2000, the second device will be installed automatically.  For other versions of
Windows, the above process may need to be repeated to complete the instrument installation.
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3 Using EasyScope II

3.1 EasyScope II Overview

The EasyScope screen is split into several functional areas as shown in the picture below. The
sections that follow illustrate how to use the settings to control the functions of the instrument.
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3.2 Front Panel Functions

3.2.1 Run/Stop and Single Buttons

On starting EasyScope, the program is in idle mode and displays two buttons on the bottom toolbar
with the captions "Single" and "Run".  In order to display a trace on the oscilloscope you need to
click on either of the "Run" or "Single" buttons.

On clicking the "Run" or "Single" buttons captured data will be displayed on the screen providing
that the trigger conditions are met or auto trigger is enabled.

The "Run" button is used to continuously capture and display data.

When the "Run" button is clicked, the capture / display begins and the caption of the button
changes to "Stop".  The "Single" button is "greyed-out" as the two functions are mutually exclusive.
To stop the capture, click on the "Stop" button and the oscilloscope will change back into idle
mode.

The "Single" button captures one screen's worth of data then returns the program to idle mode.

When the "Single" button is clicked, the instrument waits on the trigger conditions being met before
updating the display with a single buffer of data and the caption of the "Run" button changes to
"Stop".  The "Single" button is "greyed-out" as the function is currently running.  If the instrument
does not trigger, it can be returned to idle mode by clicking the "Stop" button.

The last captured data buffer will remain displayed on the screen as long as the user does not
change any of the oscilloscope settings.  If desired, the screen display can be saved to a Windows
Bitmap (.bmp) format file, exported to a comma separated values (.csv) file for analysis using third
party programs or can be printed by any printer connected to the P.C.  These subjects are dealt
with in later topics.

An alternative to the Run / Stop button is provided through the File Menu at the top of the
application screen.  Click on "File" to select the drop down menu shown below.

Click on "Run" or "Stop" as desired.  Clicking on "Exit" will quit the EasyScope application.

A further way to stop data capture is to click the button on the PenScope casing while EasyScope
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is collecting data.
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3.2.2 Timebase Settings

The timebase settings are adjusted by clicking on the rotary switch in the Timebase Panel.  There
are 19 possible settings ranging from 50 ns/division (fastest) to 50 ms/division (lowest).  Please
note, at the lower speed settings there will be a noticeable delay between clicking on the "Run"
button and the trace appearing on the oscilloscope screen.  This is because the sampling
(conversion) rate is low and it takes more time to capture a buffers worth of data.

The button for 1GHz OverSampling will become checked for timebase settings of 0.5ms or less.

The timebase setting changes the sampling rate of the oscilloscope.  The sampling rate is
displayed on the bottom right of the oscilloscope panel shown below.
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3.2.3 Input Gain Settings

The input gain is adjusted by clicking on the Volts/Div rotary switch on the main panel shown
below.

There are 7 gain settings available.  Please note that if a gain setting is too high for the input signal,
clipping will occur.  To avoid clipping, select a larger voltage scale.

In addition, the settings depend on if the oscilloscope probe used is a x1 (1MW input impedance)
or a x10 (10MW input impedance).  If a x10 oscilloscope probe is used then enable the X10 setting
by clicking on the X10 button located below the rotary switch.  This will re-scale the switch and
display cursor settings by a factor of 10.

In the picture above, the oscilloscope is setup for a x1 probe.  The panel below shows the
oscilloscope setup for a x10 probe.

The current gain setting is also displayed on the bottom right of the oscilloscope panel alongside
the sampling rate.



18Using EasyScope II

© 2006 USB-Instruments



19 EasyScope II for PS40M10 Help

© 2006 USB-Instruments

3.2.4 GND Offset

The ground (0V) reference for is shown by a small arrow on the left hand side of the screen.  The
colour of the arrow is the same as the trace, the default for which is yellow.

To adjust the ground reference setting, drag the Up/Down "GND Offset" slider on the main control
panel.  Small changes can be made by clicking.  The offset can be changed both in idle mode and
in run mode.



20Using EasyScope II

© 2006 USB-Instruments

3.2.5 Trigger Settings

Basic trigger settings are configured using the controls on the main control panel.

The default trigger mode is for edge triggering.  Other trigger modes are explained in the
Trigger Menu section.

Selecting "Auto" will allow the scope to free-run and constantly collect data without waiting for a
trigger event.
Selecting "CHA" will force the scope to wait on a trigger event defined by the other trigger controls
before the display is updated.

Select a rising or falling edge event to trigger on by selecting "+ve" (rising edge)
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or "-ve" (falling edge).
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Use the "Trigger Level" slide bar to set the desired trigger level voltage.  The trigger level is shown
as an arrow with a "T" to the right of the oscilloscope screen and is displayed numerically above the
plot.
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3.2.6 AC/DC Coupling

AC/DC coupling is controlled by miniature relays inside the oscilloscope.  To select AC or DC
coupling click on the AC/DC selector switch on the main control panel.  This will instruct the
oscilloscope to change the coupling from AC to DC or vice-versa.  The current selection is
highlighted in green to the right of the switch.

The above picture shows AC coupling selected.
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3.2.7 Invert

The invert button is located on the main control panel.

Clicking the invert button has the effect of flipping the captured data about the ground reference
value.
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3.2.8 Horizontal Slide Bar

The horizontal slide bar beneath the plot area may be used to scroll forward and backward through
the data buffer.  The trigger point is in the middle of the buffer.

To operate the slide bar, click on the slider (positioned in the centre by default) and drag it to the
desired position.  The display will update as this is done.
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3.2.9 Illuminate

The illuminate button controls the brightness of the grid on the scope display.

With the grid illuminated, it is a bright green colour.

When the grid is not illuminated, it is a dark green.  These colours are the default and may be
customised through the Screen Menu options.
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3.2.10 FFT Display

3.2.10.1 FFT Overview

A fast Fourier transform (FFT) window may be accessed by clicking the FFT Display button.

The FFT window will appear and is shown below.

There are two cursors which may be used to measure differences in frequency.  To the top of the
cursors are marker blocks 1 and 2.  To move a cursor, place the mouse pointer over the marker
block you wish to move, and holding down the left mouse button drag the cursor to the point you
wish to measure.

The units for the vertical scale may be changed between linear and logarithmic units by clicking on
the blue area beneath the chart next to the word "Amplitude".

When the zoom function is active, the scroll bar at the bottom of the plot area may be used to scan
through the FFT data.
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3.2.10.2 Man

Clicking the "Man" button in the FFT window enables the up/down buttons and changes the button
caption to "Auto".  This allows the vertical scale of the plot to be changed manually.

Clicking on "Auto" will enable autoscaling for the vertical axis.
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3.2.10.3 Averaging

The averaging option may be used to help eliminate noise from measurements.

The averaging options available are none, 5, 10, 20 and 50 sweeps.
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3.2.10.4 Zero Pad

Zero padding may be used to artificially increase the number of data points included in the FFT.
The default is no zero padding and using the 1024 points obtained from the data buffer.

Zero padding will allow the use of either the standard 1K buffer or zero padded 2K, 4K, 8K or 16K
data sets.

Increasing the zero padding has the effect of stretching the frequency axis which will allow more
accurate measurement with the cursors.

The picture below shows the FFT of a 3V 150KHz square wave with no zero padding.

The picture below shows the same input signal with x4 zero padding.
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3.2.10.5 File Menu

The File menu (shown below) allows access to the two features described below:

Save As
This allows the FFT screen to be saved as a Windows Bitmap (.bmp) file.  When selected, a Save
As dialog box appears and prompts the user for a filename.

Print
The print option allows the user to send the FFT screen directly to an installed printer.
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3.2.10.6 FFT Window Menu

The FFT screen display can changed to use a number of different windowing algorithms.  The
available windows are displayed when the FFT Window menu is selected (shown below).

The default window is Rectangle.
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3.2.10.7 Spectrum Menu

The FFT screen display can be changed to use a number of different ways of scaling the Y-axis
through the spectrum menu.

The available scaling options are Power (V2), Magnitude (mV) and Phase (Rad).  As indicated in
the FFT Overview section, by clicking the blue area on the axis of the FFT plot, the units can be
changed between linear and logarithmic for each of these settings.

The default spectrum is Magnitude.
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3.2.11 Meter Display

The Meter Display button function displays a small panel (shown below) showing 3 measurements
of the data displayed at that time.  The default measurements are mean Voltage, peak-to-peak
Voltage and frequency.

The measurements displayed can be changed by clicking the Configure button at the bottom of the
Meters panel which brings up the following window.

Available measurements are:

· Mean Voltage
· True RMS Voltage
· Peak to Peak Voltage
· Minimum Voltage
· Maximum Voltage
· Frequency
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3.2.12 Timing Cursor

The "Timing Cursor" button is used to enable or disable the horizontal cursors.

The horizontal cursors may be used to measure the duration of a section of a waveform as shown
below.

The values of the two cursor positions are displayed at the bottom left of the plot area, along with
the difference between them.  The difference has a blue background and the units may be
changed by clicking on it.  If the display shows time units and the user clicks on it, the units will
change to frequency units.
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Similarly, if the display shows frequency units a click on the blue area will change the units to time
units.
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3.2.13 Y Cursor

The "Y Cursor" button is used to enable or disable the vertical cursors.

The vertical cursors can be used to measure the voltage difference between two points of a trace
as shown below.

The values of the two cursor positions are displayed at the bottom of the plot area, along with the
difference between them.
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3.2.14 Auto Set

Clicking the "Auto Set" button will launch the auto set function.  The button caption will read
"Cancel" while the auto set function is running.

The auto set function attempts to home in on a signal and display it clearly on the plot area by
optimising the timebase and gain settings for the detected signal.  If no signal is detected, the auto
set function will terminate.

The auto set function may be cancelled by clicking "Cancel".
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3.3 Menu Functions

3.3.1 File Menu

The File menu (shown below) allows alternative access to the Run and Stop functions (also
accessible through the Run/Stop button on the front panel).

The Exit option allows the user to quit the application and has the same function as the Windows

Close button .
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3.3.2 Screen Menu

The screen menu (shown below) allows access to options for customising the appearance of the
EasyScope interface and exporting data or images to files.

The menu items have the following functions:

Illuminate
This option has the same effect as the Illuminate button on the front panel.

Save Screen Image to File
This allows the plot area to be saved to a Windows Bitmap (.bmp) file.  A Save As dialog box
appears and prompts the user to provide a filename for the image.

Setup Printer
Allows configuration of a printer that is already installed.  Options include paper size and
orientation.

Print Screen Image
Sends the plot area of the EasyScope window to the printer.

Print Oscilloscope
Send the whole EasyScope window image to the printer.

Load Background from file
Allows the user to load a bitmap image as the background for the plot area.

Save background to File
Allows the user to save the current background to a file as a bitmap image.
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Customise Screen Colours
This brings up a sub-menu (shown below) that allows full customisation of the colours, fonts and
backgrounds used.  Colours can be reset to the original scheme by selecting "Restore Default
Colors".

Load Screen Colors from File
The color settings can be stored to a named file (*.col). Different color themes can be stored and
loaded quickly when required. A black and white color theme could be stored and used when
printing oscilloscope or screen images.

Save Screen Colors to File
The Customize Screen Colors menu can be used to select the display color theme which can then
be saved to file (*.col). Different colors can be used in 'Illuminate' and non Illuminate modes.

Persistence Mode
A variable persistence mode display can be selected using this option.  The persistence increment,
decrement and colors are selected in the Persistence Mode Setup window.  Infinite persistence
can be selected by setting the persistence decrement to 0.
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Persistence Mode Setup
This window enables the variable persistence mode options to be configured.

The persistence increment can be set to a value of between 1 and 64.  Every time a display pixel is
activated by the oscilloscope trace the 'persistence value' of that pixel is incremented by the
persistence increment value.  The maximum 'persistence value' is limited to 127.
The persistence decrement can be set to a value of between 0 and 15.  The persistence
decrement value is also limited to the persistence increment value - 1.  The persistence value of
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every pixel is decremented by the persistence decrement value after a trigger and trace display
event.  The minimum 'persistence value' is limited to 0.
Eight different colors can be selected to display a certain persistence value range.  The colors for
each pixel value range can be changed by clicking on the color box and selecting an alternative
color from the color selection menu.  The default persistence mode colors can be restored by
clicking on the 'Restore Default Colors' button.

Save To CSV Text File
This option exports the twenty most recent oscilloscope traces to a comma separated values (.csv)
file.  Column A contains the most recent trace through to column T which contains the oldest trace
data.  This can be used with 3rd party programs (for example Microsoft Excel) to manipulate and
re-plot the data.  The plot below was obtained from Excel using an exported .csv file.
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3.3.3 Cursors Menu

The options in the Cursors menu (shown below) have the same functions as the Timing Cursor
and Y Cursor buttons respectively.
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3.3.4 Trigger Menu

In addition to the basic trigger settings available on the front panel, this menu (shown below) allows
advanced triggering options to be configured.

The default mode is edge triggering which can be set to trigger on a +ve (rising) or -ve (falling)
edge using the front panel controls.

Pulse
Selecting Pulse from this menu disables edge triggering and enables pulse triggering.  The user
must select either Negative or Positive pulse from a sub menu (see below) and is then provided
with an Advanced Trigger window (also below).

The example shown is for a negative pulse.

The user can then select options to trigger on a pulse of length greater than or less than the time
indicated by the top slide bar.  The value of the slide bar is displayed in the box to the right and
may be changed by clicking on and dragging the slider.

This triggering method can be an extremely useful tool for finding "glitches".

The following screen shot which shows triggering on a TV vertical synchronisation signal using the
pulse triggering feature of the PS40M10.
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Delay From Trigger
The Delay From Trigger option also displays the Advanced Trigger and Delayed TimeBase Options
window.  This allows the data capture to be delayed from the trigger point by a specified time by
using the slide bar at the bottom of the window.
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3.3.5 Tools Menu

Two functions are available through the Tools menu (shown below)

Meters
The Meters option provides the same functionality as the Meter Display button.  This makes the
Meters window visible.

Test Mode
In test mode the EasyScope does not acquire real data but provides simulated data from a counter.
This allows the communication with the PC to be verified.  The display observed in test mode
should always be a saw tooth type wave with clipping occurring (see picture below).  The wave is at
a frequency of  39062.5Hz.

Test mode must be disabled to acquire real data.
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3.3.6 Help Menu

The following options are available through the Help menu (shown below).

HTML Help
Selecting HTML Help from the menu will launch this help file.

About ...
The About ... option displays version information and release dates.

USB-Instruments Web Site
This will connect to the Internet and take the user directly to the USB Instruments web site where
information can be found on products and updates.

On-Line User Manual
This option will take the user to the EasyScope II manual section of the USB Instruments web site.

On-Line F.A.Q.
This link will open the frequently asked questions (F.A.Q.) section of the USB Instruments web site.



52Using EasyScope II

© 2006 USB-Instruments

3.4 Quitting EasyScope II

EasyScope can be exited by either accessing the Exit option of the File menu or clicking the

Windows Close button  in the top right-hand corner of the window.
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4 Appendix

4.1 Error Messages

4.1.1 File Not Found

This error occurs when EasyScope II cannot find the file to program the PS40M10 hardware.

To resolve this problem click "OK", quit the EasyScope application and check that the file
PS40M10.rbf exists in the same directory as the EasyScope application program.  If the file is
there, try to re-launch the EasyScope application ensuring that the instrument is connected to the
PC.  If the file is not there, it may be retrieved by re-installing from the installation CD.
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4.1.2 Failed to Configure PS40M10

This error occurs when the EasyScope II application cannot detect any PS40M10 instruments
connected to the PC when it is launched.

Ensure that the instrument is connected to the PC and that the correct drivers are installed, then
re-launch the EasyScope II application.



55 EasyScope II for PS40M10 Help

© 2006 USB-Instruments

4.1.3 PS40M10A B Not Found ...

This error can occur when trying to run the EasyScope application with no PS40M10 hardware
connected to the PC.

To resolve this, connect a PS40M10 to the PC and run the application again.  If this has no effect,
check that the drivers are installed correctly.
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4.1.4 FT_Write - General IO Error...

This error may occur if the PS40M10 is unexpectedly disconnected from the PC while the program
is running.

A message box with this error may appear several times but will clear and run as normal after
clicking "OK" on each message box that appears.
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4.1.5 FT_GetQueueStatus - General IO Error...

This error may occur if the PS40M10 is unexpectedly disconnected from the PC while the program
is running.

A message box with this error may appear several times but will clear and run as normal after
clicking "OK" on each message box that appears.
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4.2 Uninstalling EasyScope II

From the Start -> Programs -> EasyScope II for PS40M10 menu on the Windows Toolbar, select
the Uninstall EasyScope for PS40M10 Option and click on it.

This will start the uninstaller program.  The following confirmation screen will appear.

If you are sure you want to uninstall the EasyScope Program, click on "Next".  If not, click on
"Cancel" to abort the Uninstall process.

Clicking on "Next"  starts the uninstall sequence. When the EasyScope Software is run for the first
time, it automatically creates an INI file (easyscope.ini) to store program settings and two BMP files
(DSBright.bmp and DSNormal.bmp) containing the images of the Normal and Bright screen
themes.  It is safe to delete these if asked by the uninstaller.  In the course of using EasyScope the
user may have saved some screen images and should decide if they want to keep these or not.
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Click on "Finish".
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31, 33, 34, 35, 38, 40, 41, 48

controls     13

cos     34

cos2     34

coupling     23

csv     43

Cur     38, 40, 47

Cur A     47

Cur Horiz     38, 47

cursor     28, 38, 40, 47

customise     43

customize     43

- D -
data     25, 31

dB     35

DC     23

delay     20, 48

delayed     20, 48

detect     41

difference     38, 40, 47

display     26

divisions     16, 17

driver     5, 10

drivers     5, 10

duration     38, 47

- E -
easyscope     3, 4, 5, 10, 13, 14, 16, 17, 19, 20, 23,
24, 25, 26, 28, 29, 30, 31, 33, 34, 35, 38, 40, 41, 42,
43, 47, 48, 50, 51, 52, 53, 54, 55, 56, 57, 58

edge     20, 48

error     53, 54, 55, 56, 57

exit     14, 42, 52

- F -
failed     54

failed to program penscope hardware     54

fast     28, 29, 30, 31, 33, 34, 35

fast Fourier transform     28, 29, 30, 31, 33, 34, 35

features     4, 13

FFT     28, 29, 30, 31, 33, 34, 35

file     43, 53

file not found     53

found     53, 55

Fourier     28, 29, 30, 31, 33, 34, 35

frequency     28, 29, 30, 31, 33, 34, 35, 38, 47, 50

FT_GetQueueStatus     57

FT_Write     56

function     28, 29, 30, 31, 33, 34, 35

functions     13

- G -
gain     17, 41
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Gauss     34

General IO Error     56, 57

GND     19

grid     26

ground     19

- H -
Hamming     34

hardware     54

help     51

hide     26

Horiz     38, 47

horizontal     25, 38, 47

HTML     51

HTML help     51

- I -
illuminate     26, 43

image     43

impedance     23

input     23

install     5, 10, 58

installation     5, 10, 58

installing     5, 10, 58

instrument     13, 14, 16, 17, 19, 20, 23, 24, 25, 26,
28, 29, 30, 31, 33, 34, 35, 38, 40, 41, 42, 43, 47, 48,
50, 51, 52, 53, 54, 55, 56, 57, 58

introduction     3

inverse     24

invert     24

IO     56, 57

- L -
level     20, 48

linear     35

log     35

logarithmic     35

- M -
magnitude     35

manual     29

max     50

maximum     50

mean     50

measure     38, 40

menu     42

meter     50

meters     50

min     50

minimum     50

mode     50

mV     19, 20, 48

- N -
negative     20, 48

- O -
offset     19

on-line     51

overview     3, 13

- P -
pad     31

padding     31

peak     50

peak-to-peak     50

penscope     3, 4, 5, 10, 13, 14, 16, 17, 19, 20, 23, 24,
25, 26, 28, 29, 30, 31, 33, 34, 35, 38, 40, 41, 42, 43,
47, 48, 50, 51, 52, 53, 54, 55, 56, 57, 58

persistence     43

phase     35

picture     43

points     31

positive     20, 48

power     35

print     33, 43

program     54

PS40M10.rbf     53

ps40m10b     55

ps40m10b not found     55

pulse     20, 48

- Q -
quit     52
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- R -
rectangle     34

reference     19

remove     58

RMS     50

root     50

run     14, 42

- S -
save     33, 43

save as     33, 43

scale     16, 17, 19, 29

scroll     25

seek     41

set     41

show     26

single     14, 42

size     31

slide     25

software     5, 13, 14, 16, 17, 19, 20, 23, 24, 25, 26,
28, 29, 30, 31, 33, 34, 35, 38, 40, 41, 42, 43, 47, 48,
50, 51, 52, 53, 54, 55, 56, 57, 58

specification     3, 4

spectrum     35

square     50

stop     14, 42

- T -
t/div     16

test     50

time     16, 38, 47

timebase     16, 41

timing     38

Timing Cursor     38

tools     50

transform     28, 29, 30, 31, 33, 34, 35

triangle     34

trigger     20, 48

- U -
uninstall     58

un-install     58

uninstallation     58

un-installation     58

uninstalling     58

un-installing     58

USB     10

usb instruments     51

user     51

user manual     51

- V -
v/div     17

vertical     29, 40, 47

volt     50

voltage     17, 40, 47, 50

volts     17, 40, 47, 50

- W -
web     51

web site     51

width     20, 48

window     28, 34

wizard     10

- Y -
Y     40

Y Cursor     40

- Z -
zero     19, 31
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